
November 2017 © 2017 Telestream, LLC 234515

Application Note
Vantage

Synopsis ............................................................................................................ 2

Best Practices When Using Secured Version Control..................................... 3

Upgrading Vantage with ComponentPacs ..................................................... 5

Downloading and Installing ComponentPac Updates .................................. 9

Managing ComponentPac Versions .............................................................. 11

Locking a Workflow ........................................................................................ 14

Frequently Asked Questions (FAQ) ............................................................... 15

Copyright and Trademark Notice .................................................................. 17

Note: This guide is written for video professionals who are familiar with using Vantage. To 
implement applications in Vantage, you should know how to create workflows and submit jobs. If 
you aren’t familiar with Vantage, we suggest that you review the Vantage User’s Guide and Vantage 
Domain Management Guide as needed.
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Synopsis
A compelling feature of Vantage 7.0 and later is Secured Version Control. 

Creating a perfected version of a complex Workflow is detailed and time consuming. 
Once a Workflow is completed and validated, users often have a strong desire to "not 
touch it". To support such protection, Vantage allows the Workflow to be locked, thus 
preventing edits from being made. This ensures that all new jobs submitted to the 
Workflow will work as planned. However, when a new Vantage software version is 
released with new features and improvements, many users may not install the new 
Vantage version because they are concerned about performing regression testing on 
the Workflow to ensure proper operation.

The Secured Version Control feature within Vantage 7.0 (and later) provides you the 
ability to install the latest software and begin building Workflows that utilize new 
ComponentPac libraries (software libraries), while you leave the existing Workflows 
untouched and operating on a previous version of a ComponentPac. When, and if, you 
are ready to upgrade a Workflow or action within a Workflow, you can do so at a 
convenient time. 

The Vantage components that use Secured Version Control are Analysis (Analyze and 
QC), Capture, Flip64, IPTV, Multiscreen, Post Producer (Chronicle, Compose, Conform), 
Tempo, and Timed Text Flip. These modern ComponentPacs are architected in such a 
way as to easily allow you to operate multiple versions. Legacy components such as 
General Purpose Flip, Examine, Identify, Compare and others will not support Secured 
Version Control. For the most part, the modern transcoder components provide greater 
functionality than the legacy components and you will experience significant benefits 
by upgrading Workflows to the modern actions. 

Workflows that utilize older legacy components will continue to need upgrading as per 
the historical Vantage methodology. Regression testing for these legacy-based 
workflows is recommended when you implement a new Vantage version.
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Best Practices When Using Secured Version Control
The Secured Version Control feature within Vantage 7.0 and later provides an 
unprecedented capability to enable you to selectively utilize new Vantage 7.0 (or later) 
features without compromising existing Vantage workflows. 

In order to take advantage of Secured Version Control your Vantage systems will need 
to be upgraded to version 7.0 or later (currently version 7.1). Vantage components that 
use Secured Version Control can then be upgraded in the future through Secured 
Version Control using ComponentPac packages. 

Existing Workflows that use older (non-ComponentPac) legacy component types (such 
as the Flip transcoder), will need to be upgraded using the historical Vantage 
methodology using Transcoder and Analysis installers. 

As of Vantage 7.1, these components are provided in ComponentPacs:
Analyze, Capture, Chronicle, Compose, Conform, Flip 64, IPTV Flip, Multiscreen Flip, 
Tape Capture, Tempo, and Timed Text Flip. 

Non-production regression testing is recommended when a new Vantage version is 
released. See Frequently Asked Questions (FAQ) later in this document for a list of 
Services and Actions supporting Secured Version Control.

In order to protect existing workflows, Vantage 7.0 and later allows selected workflows 
to be locked, thus preventing edits. This ensures that all new jobs submitted to the 
workflow will be processed using a consistent set of components. 

When updating your Vantage system using Secured Version Control you should: 

• Always backup your Vantage Workflows prior to updating them. (This is done for 
you automatically when an action is upgraded. The workflow is automatically 
backed-up to C:\VantageWorkflowBackup\, local to the Workflow Designer).

• Duplicate workflows you wish to update to insure you have a fall back in case the 
updated components do not perform as expected.

• Lock all Workflows that you do not plan to update.

Notes:
1. New actions and workflows created in the Workflow Designer use the latest 

installed ComponentPac. However, existing actions and workflows must be 
selected and upgraded to use the latest ComponentPac. If they are not upgraded, 
they will continue to use the ComponentPac with which they were created. See the 
Vantage User Guide for detailed action and workflow upgrade instructions.

Once an action is upgraded it can't be directly downgraded. However, you can 
restore workflows to their pre-upgraded state by importing the automatic backup 
copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the 
Workflow Designer client). Beginning with Vantage 7.0 UP1, a log file describing the 
upgrades is also included in that directory. 

If you want to change the location of automatic ComponentPac backups, open the 
Vantage Management Console, select Settings and Options, and browse for a new 
Location for workflow backups. 



Using Vantage Secured Version Control
Best Practices When Using Secured Version Control

4

2. In Vantage version 7.0, existing actions and workflows will use the latest installed 
ComponentPac if the ComponentPac used to create them is no longer present. You 
may need to recreate the action if the latest ComponentPac does not support the 
action's outdated settings. If the missing ComponentPac is reinstalled, the actions 
will resume use of that ComponentPac.

3. Starting with Vantage 7.0 Update Pack 1, workflows created with a previous version 
of Vantage (such as Vantage 6.3) will use the earliest ComponentPac installed. 
When you upgrade a workflow created with an older Vantage version to Vantage 
7.0 or later, the actions will be tied to the latest ComponentPacs currently installed.

4. The Session Log available in the Workflow Designer Job Status or Domain Job 
Status panel lists which ComponentPac was used for a completed job. 

5. If a Vantage service is unable to unpack a ComponentPac (such as when the 
Vantage service does not have the appropriate user credentials to access the file 
location of where the ComponentPac file resides), an entry is added to the service 
trace log to record the issue.

6. If you convert a single-node Vantage domain to a multi-node Vantage domain and 
if the installed ComponentPacs reside in a local path, the ComponentPacs must be 
copied or moved to a shared folder location and re-installed or re-registered.

7. Once workflows and actions have been upgraded to the latest ComponentPac they 
cannot be reverted back to previous versions.

8. Upgrading Vantage via an update pack, such as 7.0 UP1, may cause ComponentPac 
actions to be shown as eligible for upgrade even though a new ComponentPac has 
not been installed. This is normal behavior for update packs. You can upgrade the 
ComponentPac actions or not, as you prefer.

9. Attempting to install a future ComponentPac that doesn't match the current 
Vantage version fails to install the ComponentPac and displays an error message: 
“ComponentPacs built for a future release of Vantage are not supported, and will 
not be installed.” 

Summary of Notes on ComponentPac Use:
• New workflow = uses and tied to latest ComponentPac

• Upgraded workflow = uses and tied to latest ComponentPac

• Un-upgraded workflow = uses ComponentPac with which created or tied

• Workflow missing ComponentPac = uses latest ComponentPac, but reverts to miss-
ing ComponentPac if that ComponentPac gets restored

• Workflow prior to 7.0 opened in 7.0 = uses latest ComponentPac until upgraded. 
Tied to latest ComponentPac after upgrade.

• Workflow prior to 7.0 opened in 7.0 UP1 = uses earliest ComponentPac until 
upgraded. Tied to latest ComponentPac after upgrade.
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Upgrading Vantage with ComponentPacs
If you are an existing Vantage user with a version prior to 7.0, you will need to upgrade 
to Vantage 7.1 or later to take advantage of the new ComponentPacs feature. The 
upgrade procedure differs depending on the Vantage version you are starting from, as 
described in the two alternative procedures below. Please read both to determine 
which one applies to you.

Upgrading to Vantage 7.1 (or later) from Versions 6.0-6.3
1. Back up your Vantage database by using the Domain Management/Backup feature 

in the Vantage Management Console. You may also want to export all workflows.

2. In the Vantage Workflow Designer Domain Job Status, stop all jobs or allow all jobs 
to complete.

3. Close all Vantage client programs and Web applications using this domain.

4. Run the Vantage 7.1 installers on all relevant Vantage servers.

5. Upgrade all workflows and actions to allow them to be ComponentPacs aware.

a. Open the Vantage Workflow Designer. 
b. From the File menu select Batch Workflow Operations. 

c. From the Batch Workflow Operation window click Check For Upgrades. The 
Upgrade Workflow popup will appear.

d. On the Upgrade Workflow popup Click OK.
e. From the Batch Workflow Operation window, click Upgrade Now to upgrade all 

selected workflows.

6. Download any new ComponentPac or legacy component updates that you wish to 
install on your Vantage 7.1 (or later) system.

7. Install ComponentPac and/or legacy component updates. See the Vantage Domain 
Management Guide for installation details.

Important Note: For rules governing which ComponentPac is used prior to and after 
upgrading, please see the Notes in Best Practices When Using Secured Version Control.
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Upgrading to Vantage 7.1 from 7.0 or Versions Prior to 6.0
If you are upgrading to Vantage 7.1 from 7.0 or a Vantage version prior to 6.0 
(such as 4.0 or 5.0), you must first uninstall Vantage using Programs and Features 
before upgrading to Vantage 7.1. See the procedure below.

1. Back up your Vantage database by using the Domain Management/Backup feature 
in the Vantage Management Console. You may also want to export all workflows.

2. Log into Vantage Workflow Designer Domain Job Status and stop all jobs or allow 
all jobs to complete.

3. Close all Vantage client programs and Web applications using this domain.

4. For each computer with Vantage client programs installed in this domain, log in 
with a local administrator account and perform the following steps:

a. Open Control Panel > Programs and Features > Uninstall Programs.
b. Select Vantage Client Applications (if present) and click Remove or Uninstall.
c. Uninstall all Vantage update packs that are installed: Select each Vantage update 

pack in reverse sequential order (latest to oldest), and click Remove or Uninstall. 
Perform this step for all installed update packs. 

5. On the server hosting Vantage Web apps, use the Control Panel uninstall tool (see 
Step 4) to select Vantage Web Applications and click Remove or Uninstall.

6. On the servers hosting the Telestream Media Transcode and Analysis engine, log in 
with a local administrator account and follow these steps:

a. Select Start > Administrative Tools > Services to display the Services window.
b. Right-click and select Stop for the following services: Vantage Analysis service 

and the Vantage Transcode service.
c. In the Control Panel uninstall tool (see Step 4), select Telestream Media 

Transcoding & Analysis Engine and click Remove or Uninstall.

7. On the Vantage database server log in with a local administrator account, and using 
the Control Panel uninstall tool (see Step 4), follow these steps:

Note: Subsystems (IPP, QuickTime, etc.) that have been installed during Vantage 
installation are not removed, and Vantage domain data and media you have created 
are not removed.

a. Select Vantage and click Remove or Uninstall. This removes Vantage, but your 
Telestream folder, including your Database folder and files, remains in place so 
your Vantage configuration is preserved.

b. Leave MS SQL Server in place—do not uninstall it.

At this stage, the Vantage software has been removed, but your database contents and 
service configuration files and the SQL Server are still intact. When you install the latest 
Vantage, you can reuse these database files and let Vantage upgrade them. Continue 
now with the next topic, Installing the Upgrade.
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Installing the Upgrade
The following procedure upgrades an older Vantage version to a new one. 

CAUTION: Upgrade all components. Upgrading only selected components can result 
in component mismatches, causing a non-functioning Vantage system. If you have 
any questions, contact Telestream Vantage Support.

1. Log in to the Vantage server with a local administrator account, and make sure that 
virus-checking software and Windows Firewall are off. (See Anti-Virus Software 
Recommendations and Firewall Guidelines for details))

2. To protect your data, use the Vantage Management Console to back up your 
database using the Domain Management/Backup feature to create a backup file. 
(See Backing up the Existing Database for instructions.)

3. Stop any active jobs or allow them to complete. Workflows should be deactivated. 
Close any open Vantage apps.

4. Run the Vantage_7.1.exe installation archive to automatically extract and run the 
Vantage_7.1_Setup.exe installer. 

5. When the Welcome dialog appears, click Next to display the license agreement. 
Click I Accept if you agree to the license terms, and then click Next.

6. Select Upgrade existing database when the Database install mode dialog appears, 
and click Next.

This instructs the Vantage installer to upgrade your database and preserve informa-
tion for workflows, design items, job history, catalogs, stores, application configura-
tions, user settings and licenses.

7. When the Destination Folder dialog appears, accept the default folder or click 
Change to select an alternate directory on another drive; then click Next.

8. When the Ready to Install Vantage Domain Database dialog appears, click Install to 
begin installation. This process takes a few minutes to complete.

9. When installation is complete, click Finish to quit. If you are upgrading a Vantage 
Array, you have just completed the database server upgrade. Next, upgrade any 
other servers in the next step.

10. Repeat these steps for any other servers in the Array, such as servers hosting the 
transcoding engine, services, and web applications. When you run the installer on 
each server, select the components to install corresponding to the components 
you are replacing on that server.

11. When all servers and components have been upgraded, the upgrade is complete. 
Test your workflows to make sure all required items to run the workflows are still 
present and the workflows still run as expected.
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Note: Existing workflows do not require updating to run as they did on earlier 
Vantage releases. However, you might need to re-create some aspects of existing 
workflows to take advantage of new user interface components. For example, new 
options in Flip actions do not display automatically after upgrading. Refer to the 
Vantage User Guide for details about enabling new features in actions and workflows.

Note: If upgrading from Vantage 7.0 and your ComponentPacs reside in a custom 
location other than C:\Program Files (x86)\Telestream\Vantage\ComponentPacs, you 
may need to copy the 7.1 ComponentPacs from C:\Program Files (x86)
\Telestream\Vantage\ComponentPacs to your custom location. Then you will need to 
use the ComponentPac Management in the Vantage Management Console to install 
the 7.1 ComponentPacs.

You can see or change the location in which ComponentPacs reside using  
ComponentPac Management > ComponentPac storage location in the Vantage 
Management Console. 
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Downloading and Installing ComponentPac 
Updates

Follow these steps to install new ComponentPacs:

1. Download ComponentPac update file(s) from the download page associated with
the Telestream product you wish to upgrade. Go to http://www.telestream.net/
telestream‐support/overview.htm and select the associated download links.

2. When you have downloaded all ComponentPacs, move the files onto a shared
network folder that all Vantage and Lightspeed Live Capture servers within your
domain have permission to access.

Note: If the Vantage domain is a single node (all in one server), the ComponentPacs 
may reside in a local folder and a share folder is not required. However, if the 
Vantage domain is an array, the Vantage services must have permission to access 
the network location where the ComponentPac is placed. User credentials can be 
provided to Vantages services in one of two ways: (1) Change the log on of the 
Vantage services via the Windows Services console. (2) Use the Authorization tab 
within Settings & Options of the Vantage Management Console to specify 
authorization credentials for remote folder access. After applying credentials to 
Vantage services, the services must be restarted in order to complete the change.

3. Open the Vantage Management Console connected to your systems master
domain database and select ComponentPac Management from the left panel.
ComponentPacs are managed through the ComponentPac Management panel.
ComponentPac Management panel 's Installed ComponentPacs list will show all of
the ComponentPac versions that are installed in your Vantage domain.

http://www.telestream.net/telestream-support/overview.htm
http://www.telestream.net/telestream-support/overview.htm
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4. From the ComponentPac Management panel Browse to the shared network 
location where your ComponentPac update files reside and click Install new 
Packages. 

5. Confirm that all of the ComponentPacs you wish to install are listed and are 
enabled within the ComponentPacs to install window.

6. Click Install. 

The selected ComponentPacs will be installed and displayed in the ComponentPac 
Management's Installed Component Pacs window. Note that installing Compo-
nentPacs will not affect any running jobs or workflows. The ComponentPac Install 
process unpacks each ComponentPac package and places its contents onto each 
individual Vantage server. All components are copied to the <Install Direc-
tory>\Program Files (x86)\Telestream\Vantage\Component folder on each respec-
tive Vantage server.

7. Restart the services hosting the affected actions in order for the installed 
ComponentPacs to be available for use.
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Managing ComponentPac Versions
With Secured Version Control, it is quite easy to manage the ComponentPac versions 
within Workflows. ComponentPacs are software libraries that do the "heavy lifting" of 
the actions such as transcoding, analysis and conforming. When you hover over the "i" 
icon at the top left corner of an action, information is displayed which includes the 
version of the ComponentPac library. In the following image, the IPTV Flip action's 
ComponentPac is shown as "IPTV 7.0.0.197022". 

When a new version of Vantage is installed, this action must specifically be selected and 
upgraded to the latest version of software. If it is not upgraded, all processing through 
this action will continue to utilize the previous version of the software.

Note: If you suspect multiple actions may use a ComponentPac that has been 
removed, you can use the Find actions referencing an absent ComponentPac button in 
the main ComponentPac Management panel to locate actions that need upgrading to 
use a new ComponentPac after a previous one has been removed. 
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Upgrading Actions and Workflows
To upgrade an action, right-click the action to bring up the context menu and select 
Upgrade. The next time the action runs, it will utilize the new library. This allows 
upgrading the action at the most convenient time, rather than at the time of the 
software upgrade.

If a new Workflow is created, the new actions added to the Workflow will automatically 
utilize the latest ComponentPac.

Once the action has been upgraded, the new version can then be identified by 
inspecting the action. In the following figure, the IPTV Flip ComponentPac is now 
utilizing a library called "IPTV 7.0.0.197033".
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Not only can individual actions be upgraded, but also entire Workflows. By duplicating 
the Workflow to be validated and then upgrading it to the new version of Vantage, it 
becomes quite easy to perform Workflow regression on new versions of software 
without compromising the integrity of the original Workflow.

Note: Once an action is upgraded it can't be directly downgraded. However, you can 
restore workflows to their pre-upgraded state by importing the automatic backup 
copy that Vantage places in the C:\VantageWorkflowBackup directory (local to the 
Workflow Designer client). Beginning with Vantage 7.0 UP1, a log file describing the 
upgrades is also included in that directory. 

Workflows can be upgraded by using the Workflow Designer > File > Batch Workflow 
Operations menu, which opens the Batch Workflow Operations panel. Select a 
workflow in the panel, or Ctrl-click/Shift-click to select multiple workflows. Then click 
Check for Upgrades. If upgraded ComponentPacs are available, a dialog will guide you 
to complete the upgrade.
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Locking a Workflow
When a Workflow is validated and working correctly, Vantage provides the ability to 
"lock down" the workflow to prevent accidental changes. Additionally, this lock 
mechanism also prevents upgrading the ComponentPac version for the workflow as 
well. If a Workflow, or actions within a Workflow, is desired to be upgraded, then the 
Workflow must be specifically unlocked.

To lock a Workflow, right-click on the Workflow in the Vantage Workflow Designer to 
bring up the contextual menu and then select Lock. A "lock" icon shows up next to the 
locked Workflow.

Similarly, to unlock a Workflow, right-click the Workflow and select Unlock.

[

Note: Secure Version control will not protect workflows against upgrades to the 
"legacy" services.
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Frequently Asked Questions (FAQ)
Q: Which Vantage Services and Actions are NOT managed by Secured Version Control’s 
ComponentPacs?

A: These services are NOT managed by Secured Version Control’s ComponentPacs:

• Monitor Service (Associate Action, Camera Ingest Action, Watch Action, Workorder 
Action)

• Traffic Service (Catch Action, Dublist Action)

• Cloud Service (Cloud Flip Action)

• Metadata Service (Populate Action, Transform Action)

• Catalog Service (Exist Action, Register Action, Remove Action)

• Analysis Service (Action, DPP Validate Action, MediaInfo Action, Report Action)

• Edit Service (Colocate Action)

• Transform Service (Copy Action, Delete Action, Deploy Action, Move Action)

• Common Service (Compute Action, Construct Action, Decide Action, Forward 
Action, Receive Action, Synchronize Action)

• Staging (Archive Action, Gather Action)

• Communicate (Automate Action, Message Action, Notify Action)

• Transcode ( Flip Action)

• Analysis (Compare Action, Examine Action, Identify Action)

• All Third Party Services/Actions 

Q: Where are the unpacked contents of ComponentPacs stored when they are 
Installed?

A: The contents of ComponentPacs are unpacked and stored into <Installed 
Drive>:\Program Files (x86)\Telestream\Vantage\Components\ on each server within 
the Vantage domain.

Q: What happens if the contents of the ComponentPacs cannot be unpacked and 
copied to one or more of the Vantage servers in the domain?

A: If a service is unable to unpack a ComponentPac, an entry is written to the service 
trace log. Service trace logs can be found within each service’s Vantage folder 
<Installed Drive>:\Program Files (x86)\Telestream\Vantage\[Service Name].

Q: How are ComponentPacs uninstalled?
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A: To uninstall a ComponentPac, follow these procedures:

a. Export and delete all workflows containing an action that uses the 
ComponentPac you wish to uninstall. 

b. From the Vantage Management Console’s ComponentPac Management control, 
select the respective ComponentPacs, and click Uninstall.

c. Restart services associated with the uninstalled ComponentPac, and close and 
reopen the Vantage Workflow Designer.

If an action is configured to use a ComponentPac that is not installed, it will use 
the latest available installed ComponentPac.

Q: What happens with workflows created prior to 7.0 that include actions under 
Secured Version Control?

A:  With Vantage 7.0, if a workflow was created with a version prior to Vantage 7.0, it will 
use the latest installed ComponentPacs until each action is upgraded. Once an action is 
upgraded, it is locked to the current ComponentPac.

Starting with Vantage 7.0 Update Pack 1, workflows created with a previous version of 
Vantage (such as Vantage 6.3) will use the earliest ComponentPac installed. When you 
upgrade a workflow created with an older Vantage version to Vantage 7.0 or later, the 
actions will be tied to the latest ComponentPacs currently installed.
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Copyright and Trademark Notice
©2017 Telestream®, LLC. All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, altered, or translated into any languages without 
written permission of Telestream, Inc. Information and specifications in this document 
are subject to change without notice and do not represent a commitment on the part 
of Telestream.

Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, 
ScreenFlow, Switch, Vantage, Wirecast, Gameshow, GraphicsFactory, MetaFlip, and 
Split-and-Stitch are registered trademarks and MacCaption, e-Captioning, Pipeline, 
Post Producer, Tempo, TrafficManager, VidChecker, and VOD Producer are trademarks 
of Telestream, LLC. All other trademarks are the property of their respective owners.

All other brand, product, and company names are the property of their respective 
owners and are used only for identification purposes.
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